
Working with Access Rights



Working with Access Rights

Working with Access Rights
The editing of documents can be limited for third parties using access rights.
This function is particularly helpful if as a user you want to create documents
that other users are only allowed to edit according to certain criteria. These
users should for example only have the possibility of entering text or moving
images. As the creator of the documents you protect them with an individual
password and you can unlock the documents with the password to edit them
yourself.

Options for Access Rights
The definitions for the access rights are made in the Preferences for the function areas Docu-
ment, Output, Layout & Content and Palettes. For these preferences the same rules apply as
those for all other preferences. This means: All options are only valid for the current document.
If no document is open, then the settings will be valid for all new documents.

Options for Documents

You define general preferences for the document in the Document dialog area.

Allow Save — With this option, you define whether the document may be saved.

Allow Save As — With this option, you define whether the document may be saved under
another name.

Import — With this option, you define whether text and images may be imported.

Edit Document Settings — With this option, you define whether the document settings may be
changed.

Edit Preferences — With this option, you define whether the Preferences may be edited. If the
option is activated, a user can change the access rights at any time, whether a password has
been applied or not.

Edit Colors — With this option, you define whether the colors may be edited.

Edit Style Sheets — With this option, you define whether Style Sheets may be edited.

Note:
When the option is selected and the option Edit Text is not deactivated, it is still possible to
format the text by altering the Style Sheets.
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Options for Output

You define the output options for the document in the Output dialog area.

Allow Printing — With this option, you define whether the document may be printed..

Allow PDF Export — With this option, you define whether the document may be exported as a
PDF file. This option has no effect on editions that do not possess any PDF export (e.g. “Free
Edition”).

Allow EPS Export — With this option, you define whether the document may be exported as an
EPS file.

Allow PS Export — With this option, you define whether the document may be exported as a
PostScript file.

Allow JPEG/PNG Export — With this option, you define whether the document may be exported
as a JPEG or PNG file.

Allow Text Export — With this option, you define whether a text chain (story) may be exported
as a text file.

Allow High Resolution Output — With this option, you define whether the images in the docu-
ment may be output in high resolution or preview quality.

Options for Layout & Content

With the options in the Layout & Content dialog area, you define how the layout or the content
of objects (Text, Images, etc.) may be edited.

Edit Objects — With this option, you define whether a user may edit objects at all. If the option
is not selected, no new objects may be created, selected or deleted. This also goes for all Drag &
Drop operations, with which for example images are placed on a document page.

Move Objects — With this option, you define whether a user may move or nudge objects.

Stretch objects — With this option, you define whether a user may stretch or resize objects.

Modify Objects — With this option, you define whether a user may modify objects.

Create Objects — With this option, you define whether a user may create objects.

Delete Objects — With this option, you define whether a user may delete objects.

Manage Pages — With this option, you define whether a user can manage document and Alias
pages. If the option is not selected, no new pages may be added, no pages may be deleted/
removed, no Alias pages may be displayed, and no Alias pages may be assigned to a docu-
ment page.

Edit Text — With this option, you define whether a user may enter or delete text. The possibil-
ities a user has for formatting text depend on the options Module Palette and the Style Sheets
Palette.

Edit Pictures — With this option, you define whether a user may edit pictures/images. If the
option “Edit Pictures” is not selected, no image crop may be changed. A user can however
import a new picture into an existing frame, providing the option Modify Objects is selected.
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Edit Tables — With this option, you define whether a user may edit the construction of a table.
If the option is not selected, no cells may be selected and no settings for the table, rows, col-
umns or cells may be made.

Note:
- If the option is selected and the option Module Palette is not selected, the table settings

can only be selected with the context menu.
- If the option is selected and the option Modify Objects is not selected, only single cells and

no table rows or columns may be selected.

Options for displaying palettes

With the options in the Palettes dialog area, you define which palettes can be displayed. If an
option is not selected, the palette will be hidden automatically when switching between docu-
ments, and the appropriate options will either be hidden or grayed out in the View menu

Module Palette — With this option, you define whether the palette can be displayed. If the
option is not selected, no individual settings may be made in text, picture or object modes. The
option controls the display of the menus Text, Picture, Table and Object.

Picture Palette — With this option, you define whether the palette can be displayed.

Layer Palette — With this option, you define whether the palette can be displayed. The option
should only be selected when at least one option under Modify Objects is selected at the same
time.

Page Palette — With this option, you define whether the palette can be displayed. The display
of the Page Palette is dependant on the option Manage Pages.

Color Palette — With this option, you define whether the palette can be displayed. The option
should only be selected when the options Modify Objects and Edit Text are selected at the same
time.

Style Sheets Palette — With this option, you define whether the Style Sheets Palette can be dis-
played. The option should only be selected when the options Modify Objects, Edit Text and Edit
Pictures are selected at the same time.

Search & Replace Palette — With this option, you define whether the palette can be displayed.
The option should only be selected when the option Edit Text is selected at the same time. The
Search & Replace options work independently of the options for formatting text. Therefore a
user can exchange fonts or Style Sheets, although he is not allowed to do this by other options.

Spell Check Palette — With this option, you define whether the palette can be displayed. The
option should only be selected when the option Edit Text is selected at the same time.

Character Inspector Palette — With this option, you define whether the palette can be dis-
played. The option should only be selected when the option Edit Text is selected at the same
time.

Trapping Palette — With this option, you define whether the palette can be displayed. The
option should only be selected when at least one option under Modify Objects is selected at the
same time.
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Apply Password Protection

The settings for access rights only take effect if they are protected with a password. Passwords
for layers or Alias pages remain unaffected.

The settings for access rights take immediate effect when you apply a password, confirm the
settings and save the file.

Users who do not possess a program version to unlock the access rights or do not know the
password can only edit the document according to the criteria that have been set. To unlock
the document for full editing, they must enter the password that has been defined. The
“unlock” function only works for the current editing session. If they edit the document and
then save and close it, the protection remains. To unlock the document permanently, the exist-
ing password must be deleted.

Applying Access Rights

Create access rights for a document

1. Choose the command Edit > Preferences > Access Rights.

2. Choose from the options described above.

3. Click the Password button.

4. Enter a password in the Password entry field and repeat the entry in the next entry field.
Choose the option Make visible to display the password in clear text on the screen.

5. Click OK to confirm the password.

6. Click OK to confirm the settings for the Preferences.

Unlock access rights temporarily

1. Open the document with access rights.

2. Choose the command File > Enable Access Rights.

3. Enter the Password you have defined.

4. Click OK to confirm the password.

Change access rights for a document

1. Choose the command Edit > Preferences > Access Rights.

2. Choose from the options described above.

3. Click OK to confirm the settings for the Preferences.

It is not necessary to re-enter the password.

Remove access rights settings permanently

1. Unlock the access rights temporarily if necessary.

2. Choose the command Edit > Preferences > Access Rights.
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3. Click the Password button.

4. Do NOT enter a password and click OK button to confirm the empty password.

5. Click OK to confirm the settings for the Preferences.

The access rights for the document are now permanently removed, although the corresponding
options are selected in the Preferences. These will be reactivated when a new password is
entered.

Tips and Tricks for Access Rights
- Think up a concept for applying the password or use one password for all documents. This

will make your work easier.

- Save a backup copy of the document without the password, as if you forget the password
the document can never be unlocked!

- If you choose the option Edit Preferences, you can test the effects of the different options
for access rights immediately, if you confirm the Preferences with OK. Then you don’t have
to save and re-open the document with every alteration of the access rights.

- If you set the access rights when no document is open, these settings will take automatic
effect on all new documents.

- The access rights have a global effect on all objects of the same type. If for example you
want to define that the user may only edit certain texts or images, you must set protection
for the content of the other text and picture objects and perhaps also lock their position on
the page. Please see the descriptions in the chapter Working with Objects and/or Working
with Layers.

- If you want to define that the user is allowed to edit only certain Alias pages or none at all,
you can protect the Alias pages with a password. Please see the descriptions in the chapter
Working with Pages.

- Users of a “Free Edition” are not able to switch off the access rights temporarily or perma-
nently due to the program version. Users of other versions can only do this by using the
password. You can therefore at any time pass the documents on to third parties, who can
edit them with the free of charge “Free Edition”.
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Notes for the creation of template documents

Introduction

You can limit the editing options for open documents with the help of access rights. The
advantage of this technology lies in the fact that you can redefine an existing layout as a tem-
plate in just a few minutes. This does however have the prerequisite that in the layout construc-
tion certain aspects have been considered that will also enable further editing at a later date.

Here with very few exceptions it is irrelevant whether you have created the layout in
VivaDesigner or in another program (e.g. Adobe InDesign) and then imported it to
VivaDesigner. The procedure is always the same:

Step 1:

Work out a concept to define which editing options you want to give to a user for a document.
Every document can have different editing options.

Step 2:

Apply the access rights concept to the layout. Check in existing documents if all points have
been addressed in the concept.

Step 3:

Apply access rights to the document.

Step 4:

Check the functionality of the access rights to ensure that all the required options are available
to the user.

Conceptual Hints

When creating and preparing documents you should always consider which options a user will
have, based on the access rights for document editing. If for example, based on the access
rights, the user:

- cannot create his own pages and/or objects, all the necessary pages and/or objects must
be available in the document.

- cannot stretch or resize objects, all text objects must be so created that they can display
the required amount of text.

- cannot move/nudge objects, the layout must be so constructed or adapted that the posi-
tion of dependant objects is calculated automatically.

- cannot apply individual attributes to text, all the necessary Style Sheets must already be
available in the document.

- cannot apply any attributes to text, the appropriate sample text must be available and
possess the necessary attributes.

With this background, you may need to adapt the construction of existing documents without
changing the layout. when creating and preparing the templates, you should always take into
consideration that another user7
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- must be able to find his way through your document and edit it without any initiation or
training.

- may have less functions at his disposal for the editing of the document, depending on his
access rights.

- may only change the document in the ways prescribed by you.

The user will only get along in your document if he can immediately identify which functions
are available to him. This includes working with pages, objects, text, Style Sheets or images.

Hints for document pages

- Delete all unnecessary document pages.

- Delete all unnecessary Alias pages, insofar as the user has access to the Page Palette.

- Protect Alias pages with a password if necessary.

Hints for objects

- Delete all objects from the working area so as not to confuse the user.

- Objects which are repeated on different pages and should not be edited can be placed on
Alias pages.

- All other objects that are not to be edited can either be protected or placed on special lay-
ers which are then locked.

- Alternatively you can place all the objects that are to be edited on one layer, and lock all
the other layers. In both cases you don‘t have to protect the layer with a password if you
don‘t give the user the possibility of selecting a layer. Do however ensure that when you
save the document, you have selected the layer that the user is later to edit.

Hints for graphic and picture objects

- Graphic objects should be drawn as graphic objects and not as empty picture objects. Oth-
erwise the impression is created that one can/should import images into these objects.

- Check whether you want to fill picture objects with example images, or whether you will
just provide the user with empty picture objects. Please remember that when importing
images the scaling options will be taken over automatically if an image has already been
imported into a picture object. This is also a possibility for predefining the scaling for a
picture object.

Hints for text objects

- Work out a concept for sample text. Check whether you want to fill text objects that the
user will edit with sample text and how you assign attributes to it. Remember that all text
that the user does not delete or edit will also be output later.

- Work out a concept for dynamic ordering of elements. Check whether the layout should
automatically adapt if the user enters more or less text:

- The headline and following text should not be placed in separate text objects if the length
of the headline is variable.
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- Pictures/images should be anchored in the text (as floating objects) if the image position
is dependant on the amount of text.

- Images and text can be placed in tables with a fixed height and so defined that the height
of the images is adapted to suit the text length. For this purpose the height of the row for
text must be set to Auto and the height of the row for images must be set to 100%.

Hints for text style sheets

- Only use Style Sheets to assign attributes to the text if the user can only assign Style Sheets
to his text. With the option View > Text > Visualize Style Sheets you can check very quickly
to which text Style sheets have been assigned.

- Choose Style Sheet names whose function can be recognized. (e.g. Headline, Body text,
etc.).

- Where possible, use the predefined names in the program for text Style Sheets if the docu-
ment will be used in different countries. These names are translated automatically when
the program interface language is changed.

- Create Character Style Sheets for Bold, Italic, Superior, Inferior, when such attributes are to
be used in the text and the Module Palette is deactivated.

- Text that the user may not edit (e.g. on protected Alias Pages or locked layers) should not
be assigned with Style Sheets, as errors or text overflow in text objects and tables could
occur if the user has by chance been allowed to edit Style Sheets.
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Hints for the creation of templates in InDesign
You can also create a template in InDesign and import it into VivaDesigner. For this purpose
please refer to the section Exchange with InDesign. Please also refer to the additional hints
below.

Marking objects

If you want to create templates in InDesign or receive them from third parties, you need to
work out a concept for marking the objects to be edited in these programs. There are many
possibilities for this:

- If you want to take over documents from InDesign in VivaDesigner, it would for example
be useful to create a layer and to place colored objects on this layer that lie on top of the
objects to be edited.

- In version 7.1 of VivaDesigner, the import of layers from InDesign is also supported. Then
you can place the objects to be edited straight on the appropriate layer.

Delivery of InDesign documents

If you do not possess InDesign, it has already proved to be practical if the creator delivers the
templates in three formats:

1. In IDML format for importing into VivaDesigner,

2. In native INDD format (for archive purposes) and

3. In PDF format for a visual check if the import into VivaDesigner has functioned correctly.

Construction of InDesign documents

InDesign has a series of functions that VivaDesigner does not support. Among these is the dis-
play of text on character paths. At the same time, VivaDesigner has a series of functions that
InDesign does not support. Among these are for example the use of “Layouts”, Drop Caps with
outlines as well as backgrounds and frames for paragraphs and/or characters. To see which
content will be imported by VivaDesigner, please refer to the section Exchange with InDesign.
Basically, however, you should pay attention to the following in InDesign:

- Do not use different page formats in one document (from CS 5.5)

- Do not use any text over several columns in one text (from CS 5.5). VivaDesigner also has
such a functionality but this must be built up in a different way.

- Avoid converting text to paths.

- Avoid using complex character paths.

- Avoid using text on character paths.

- Do not use image files in PSD format. Instead, use image files in PDF, TIFF, PNG or JPG format.

- Avoid using image files in EPS format. Instead, use image files in PDF format.

- Do not use color blends (gradients) containing several colors. Instead, use linear blends
with two colors.

- Avoid using individual line samples. Only use the standard samples.10




